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Set up CadStar

* Map Drive \\Felt\Elab\FYS4260

i i |
e 2 »

=]

Tempiste

+ Start CadStar
— All Programs -> CadStar 17 -> Design Editor
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Select File menu -> Options
CIEERADE SV RN L e |

Home Symbol Net / Shape Design Hierarchy Library Report Tools

I New Recent Designs al B —bBus
[i5 Open rence & Attribute
C:\Wo..\RingLEDCounter v3.sem Connection
Save A Text
& save As » | C\..\Frame Rate Counter v1A.pch
& Reload Ci\.\Frame Rate Counter v1.scm
[ Close

i CA\Works..\MotionSense v2.scm
I Open Workspace

& save Workspace
15 Save New Workspace
Jj' Close Workspace

C:\Work..\MotionSense v2A.pch

Recent Workspaces

C:\Workspac..\FYS4260 IPC.
"E‘,F\Ielmpun \Workspac..\| csW

& File Export C\Workspace\Ca..\KursLib.csw
& Print ¥ CAW..\MaxiDusty Daughter.csw
B2 Change Directory C:\Works..\AEgIS - HIEMME.csw
2) Help

L3
CA\.\QB50 - NorSat HIEMME.csw

qusmm\
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System tab
* Network license: Name: watt Port: 1700

Options I&J

System | File Locations | Library Paths | Interaction | Display | Constraints | Crass Prabing | Reports | Tools | Macros|
File Setings License Seffings
MNade Locked Only
Compress Design on Save
©) Network Licensed and/or Node Locked Authorisation Selection
Enable File Lockin
5 Hast @) Gald
Silver
Security Interval: & minuies
Bronze
Undo/Reda Library Wersion Numbers User Interface Settings
Nurnber of Levels:
By Oplion — | Automatic Wersion Increment | Show Dialog Help
Q) Byltem Al
7| Display Properties Dialog Smart Update
Recard View
Changes 7| Display Yersion Waming Dialogs V| Check on Startup
oK l ‘ Cancel | ‘ Help
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File Locations tab

* Z mapped to \\Felt\Elab\FYS4260 *
* Color Files: Colours folder .
* Template Files: Templates

User Files: User folder

Recomend to set Initial Design
Directory to your work folder.

N
Cptions =5
File Locations | Library Paths | Interaction | Display | Constraints | Cross Probing | Feports | Tools | Macros|

File types Location

C\wiorkspacel,

C\Users\Public\ Zuken\CADSTAR 17.0\Marrast
Manufacturing Output C:\warkspace| CadStar\CadStar Outputl
Output DatasheetFiles  C:\CadLibs\cadstar\HS\Output Datasheetst
Output Repart Files C:\warkspace| CadStar\CadStar Reparts\,
PREditor Configurafions  C:\Users\PubliciZuken\CADSTAR 17.0PREditor Canfigurations’
Reuse Files C:\warkspace! CadStar\CadStar Fieuse blocks!
Selection Files Ch\Cadlibs\cadstarnSelections)
Sirnulation Likraries Cilsers\Public\Zuken\CADSTAR 17.04SimLiby
Template Files 7\ Templatest
UserFiles 7:\User}
Z:\Calours', adify.

oK ] [ Cancel ] [ Help
\
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* Remove Default cadstar library if enabled
* Add Z:\Library folder (from \\Felt\Elab\FYS4260)

Optiors =]

System | File Lacations | Library Paths | Interaction | Display | Canstraints | Cross Probing | Freports | Tools | Macros|

Ensble  Displayed Library
Library  Name Library Format

Library Paths (ordar specifies search priority)

Increase Priatity

Decrease Priory

Library Type Enabled  Library File
PCB Companent Library peblin
Schematic Symbol Library
Documentation Symhol Library
PartLibrary parts idx

PCE Seloct Library Access Library Editor
symbul lib 5CM Selact

© Ask On Save

docsym.lin Doc Select @ Auta On Close

Autornatic Rebuild of Parts Index

© Mever Never

Send Paths To Library Editor

ok | [ camcal | [ Hep
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Interactions tab
» To your preferences, see settings below
» Recomend to uncheck "Prevent Overlapping Connections"

=)

Options
| System | File Locations | Library Paths | Intersction | Display | Constraints | Crass Frobing | Reparts | Tools | Macros |

Add/Edit Segment Mode Reacability Picking Tolerance

*) Two Segment - 80 Degrees Applies Direction Fine D Coarse

@) One Segment - 45 Degrees " Mone Top to Battom

) One Segment-Frse @ Symbols @ Botiomto Top PickframList [ ]Waitfor Double Click

Delate/Cut DAl Zoom Magnification Muliiplier

[7] Ask on DeleteCut Interaction 11 0 29
Keep Rautes/Connections [ Auto Merge Cannections guatalmn ouss Yool Pan Spesc

Selection Method! ["] Electrical Rules Checking 0 upuu

Q) Overlap ») Cover [¥] Enabile Resize Markers 0 & i

Copy/Paste Delste Trim/Merge shape [ | Potate ——

[T1Paste Replaces Selection [ ]Dauble Click tem Praperties  012K"s2
Capy And Paste Varian revent Overlapping Connections
Symbols raction - PCE Report After Move/Potats

[]Copy to Bitmap ynamically Optimise Connections [ Auta Connect Mid Segment

[C] Copy to Metafile [CJEdit Segment Tidies Short Segs Ut Weld Danglers

[ Capy ta Design File [ Transter DRC assignments art Pin Names At 45 Degrees

Increrment Pins on Pasting Only Menual Swap Equivalent Pins nabls 90-degree autorouting
Cannectors Autarouta on Move

[] Acd Danglers On Capy Sof @0verap Al

0K I | Cancel ‘ | Help
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Save Workspace!

» File -> Save New Workspace

« Save in your home folder!
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Start new design

File -> New -> Schematic Design
Select FYS4260 template

-> Add project name -> OK

-> Save design,
Use filename format:

username_projectname_version.sch
eg halvorst_ISM_v1.sch

- Always use a version number for the
schematics, we will use letters for the
pcb versioning.

- No version control in CadSTAR, use
save as.

- Use kurs-fys4260@fys.uio.no for all
deliveries.

New SCM Design

Design Tite

ADD FROJECT NAME

Units

Units Millimeires

Displey grid
) Cispley gid
Colowr Templste

Calow File

Marme Rangs

Amibutes

X

Sp 2590

[DEFAULT)

- Mumber of Decimsl Places 3

254 Points
£540 Gridtype:  E9I

Name Fange By Shest

Sheet Hame

Doc Sym Referencel

Doc Sym Position]
Attribute Value

—

Attribute Name

0K Cancel

Help
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Views

Mido oM aw QAREH 4,

Color Settings

—
WC - Untitled:1 - TOP - Schematic - Zuken CA

Home  Symbol

Design

Tools | View

Hierarchy

Edview All @, Zoom In IZ1Open Designs| i) Item Properties & Previous | [ Close

@ on @, Zoom Out 5 Current Design (3¢ Shape Properties T = Next ' Close All
ro
[ Frame View [ Libraries “4l Start Page +J 87 switch -
Zoom Panes Tab Document

] Open Designs
O |Z Open Designs

Blsaq juaL

48 ISM TXRX.pcb (C:\Workspace\FYS4260\2016\Nye {

Activate Views

Use pin symbol to select visible or auto hide
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Grid

Thousandths of an inch

R P = mIIS
N 8 1 mil=25.4/1000
g =0.0254mm
et Millimetres 2 mll - 005mm

...... Metres

...... Anguler  Certmeties g 4 mil~0.1mm

MNurber of Decimal Places 1

100 mil = 2.54mm

ok | [ Cancel | [ Heln |

Y} MotionSense v2.scm - MutmnSemi [

] Yefed ComponentN"' T e —
mm  Grid: 2.540

Left / Right click to change grid settings
ALWAYS use 2.54mm (100mil)in schematics
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Symbols

» Symbols are graphical representations,
pictograms, of physical parts.

J_ CAPACITOR v POLARIZED CAPACITOR

H

Z [:] RESISTOR ? - INDUCTOR
-
[ OPERATIONAL AMPLIFIER : o

DIODE
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One symbol can be different parts

= DR X ®

ZER
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PCB Library

* We need a library that maps the symbols to the real functional
chip.

+ A PCB library is a collection of parts, where each part has its
own graphical symbol and a "footprint” that the part is going to
be soldered to.

\ Part description file, links —
symbol and component
together to form a part.
Sets part parameters

Pinmapping
0201 - Value
- Mnfg partnr
402 — - Datasheet
- Order nr. etc...
PE03 T~

1206
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Multiple symbols, One part

« Components with multiple functions can be
divided into separate symbols, called gates.

» Ground all inputs on unconnected gates!

X
(XX X )
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) Add Symbol by Part ﬁ
Adding parts -

Library Peth ALL

Method One ™

[POT/1KD0/23B/SMD
RES/1K00/0402

+ Home meny REs KRR
-> Part or Symbol
» Search, using *xxxx*

Left click to place, esc to

abort | o,
» Be carefull not to add Z“:m“'" fﬂmﬂm
just an empty symbol,
but a full part Atemate Name
5o Detault Alermate
Gate Modifier
Scale (Mul:Div: 1 Fised
Orientation: 00 —
Posi v
Add Cancel Help
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5| Libraries v @
B
= Libraries -
. = £1 FYS4260 IPC Lib
Adding parts 0P 0402
g CAP 0603
Method TWO el CAP SPES
gl CAP Tantalum
&l Connectors
& Inductors
£ Parts

* Libraries View
-> Drag and drop = ApIPA00RD150

. * * = BUCK/EP5358HUI/QFN16
. Search, using *XxXxx = BUCK/EPS358LUIQFN1G
= CHARGER/bq24045/SON08
= CHARGER/bq24074/QFN16
= CON/AVRISP/PR3x2
1 H = DAC/DAC1215101/50T23-6

Part n am I n g Co nventl O n S = DCDC/MEV1D0512DC/DIP14
g . 2 DCDC/MEV1D05125C/SIP7
. SpeCIfIC parts. & FIDUCIAL MARK
. B FILTER/NFL21SP106/0805-3
Function/Partname/Case =
B FPGA/10M50DAF256/BGA256
. H & GYRO/MPU-6050/QFN24

Generlc parts B GYRO/MPU-6500/QFN24
B INVERTER/74AHCT1G04/SC70-5

Function/Value/Case & ISMRXTX/nRF24L01/QFN20 -

uBisaq LD ]

I

souesar [l]
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Unable to find a match for...

» If you get a warning saying «unable

to find a match for...» this is not an ——— 5
error! It is to warn you that the part
. . Unsble tofind & match for this assignment code:
you are adding to your design have Type Pad
one or more setting/property which pone weent
are not found in the current design. Shape Rounded Reciangle
You can Dril 0.000

because no assignment code of thatname exists

— Add the new setting/property to
the desing or

— Override the setting used in the
part and choose a property
already used in the design.

[ AddNewCade.. | [ ChooseBsisting Code.. | [ Cancel | [ Help

As long as you are using the correct libraries it is
always safe to add the new setting!
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Hierarchical Design

Create a new block T a6 1
* Net/Shape menu -> New Block
+ Select and draw rectangle ¢ Report  Tools  View
t [= Fillet Corner
: MNew Block @
Give the block a name [3Z Mitre Corner Q'

+ Select the new block
« Right click -> Item Properties

Increase the font [
» Select the block name -> Item Progert
» Change Text Code

Create the new level
* Doble click block name -> Create New Sheet

Create the design as a top-down design, with a top schematic
describing the overall function, and with details in the lower scheets.
Look at the schematics provided in the course projects.

Duplicate Trim/|

i
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Add connections

» Home -> Connection -> left click - left click

» All nets are identified by their net name.
— Nets are named automatically as $xxx.

— Can be changed by selecting the net -> right click -> item
properties -> Signal name

» Two nets with identical names are merged, do not
need to be physically connected with wire!

* Be aware of named nets in the project schematics!

» Use this to make it easier to identify nets when we
move to pcb later -> name all important nets!

* Makes the schematics more readable.

25.01.2018
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Global signals and Net Route Code

» A global signal is a predefined signal used for
important nets.
— To add: draw connection, right click -> global signal
— Defined in the library

» A Net Route Code is used to assign the optimal and
necked route width on a net.
— Sets max/min and optimal track widths.

— select net ->right click -> item properties -> Net -> Net
Route Code

— Must be used for GND and Power nets!

— Remember other nets that might conduct higher currents as
well, eg traces to power regulators etc.

« Multiple nets may use the same net route code!
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Block terminals

» Draw connection -> Right click -> Block Terminal
« Or draw connection to edge of existing block

e Cannot create a block terminal on an unnamed net
(You will be asked to fill in net name if you try)

25.01.2018
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Sighal References

« Draw connections -> Right click -> Signal ref
+ Select library -> smallin/out/bi

+ Give net name

+ Block terminals and signal references are just two
methods to organize the design and increase readability.
(As mentioned CadSTAR only cares about the net name)

t ID/SENSE/NC

+ GND
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Junction or overlapping connection

To prevent unwanted or missing connections, use
spacing in your schematics. Space parts, and
add short wire between to increase readability.

+ Do not connect more than 3 traces

together in one junction point. At
least be very carefull!

* In both cases it is difficult to visually
see if a connection is correct, or if

+ Do not connect symbol to symbol
without wire, or symbol directly on
a crossing wire. 7\4 ; Xg\
| #

the symbol is just overlapping the
wire or another symbol.

25.01.2018
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Decoupling / Bypass

» Every active power pin shall be
decoupled with a 100nF 0603 or
0402 bypass capacitor.

+ Use CAP/BYPASS/0402 (0603)
part in library.

» More on this later, for now just
remember to include them in the

Capacitors

schematics.

ol L

QET To§

BNF

C508
Hmo«r
€507
_‘ ABBNE
508
_‘ ABENE
§ Hmr).ur
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Tips n’ Tricks...

Use brackets in the symbol
name to add multiple

instances of the same part.

Item Properties - Symbol

Symbol Defes Symbal/Part Replace Made
Heme Modiier @ Keep Existing
5 Chi Replace
V] Rename Whole Component e =
Rislosd Pin Ne

Posion. 213440
Y B19.760
Omentation. oo

Sesle (Mul Div)

(Usefull for bypass capacitors) o
Fusd
. Mimored
Mirror part 7 .. e
@ Selection
pvs F3 to rotate o
Symbol Definition Details
L |eei-n
g
= Library Peth: {FYS4260 PG Lib symbel i
DesignVersion: &
Supplier part nr Brmicess D
D - Digikey P ——
F — Farnell S
E - Elfa Description:  CONN HEADER ZPOS 3Mh KT ANG TIN

Look the part up if you
dont know what it is!

Library Path: {FYS4280 IPC Lib}Connectars.

Part . —
Accoplance; New part not verfie
i | Pert Fin Names/Idenifiers Visible
Library Version: 4
i) Cancel Adtribules ‘ Help

25.01.2018
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P3V3
T U2
Link to Datasheets ey
2 VDDIOAID{:SCI. 7 E3W3 B3V3
| MPU_nCS 22| o & Previous View Skift+F8 L
EEE Lot 24 S View Al Arsrs | Ry Lg
MoU LMD e g popUp Cri+U 2 e
MoU =tPU_INT 12 71 (i) Item Properties...
21 % cut Ctrl+X
43 Copy Ctrl+C
7 Delete Del
= Fix
+ Select and right click parts to T
. y %% View Selection
get a link to the part’s 2 Deselect Al
datasheet. v Move =
g Disconnect Pin
* Al specific parts should have a > [t
valid link, some special purpuse < ot ran
or generic parts are missing e
datasheets i
2 Attribute.
& Assignments.
2 Colours..
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Mechanical

Add Mechanical parts to
the schematic, not
directly in the pcb.

The schematic is
always the master!

* Fiducial Marks
* Mechanical Holes

* Testpoints
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